
Getting Started

This help file contains information on all versions of the Alpha CG software.    This manual is not intended 

to comply as the specification for any particular version of Alpha CG.

Welcome to Alpha CG - a 32-bit object oriented title graphics generator software for Windows.    Alpha CG 

is designed to provide a high level of creativity and ease of use for users of wide ranges of experience.    A 

novice user will appreciate the intuitive user interface, which includes functions such as multiple undo and 

redo for easy learning and experimentation.    Many of Alpha CG’s advanced functions have been 

streamlined to a few simple operations, allowing even a beginning user to create complex title pages with 

ease after a short exposure to the program. 

For an advanced user who demands more from character generation software, Alpha CG offers 

unmatched power and quality.    It delivers superb anti-aliased titles at less than 1 nanosecond effective 

resolution, full color gradient and image texture mapped characters with variable alpha channel 

transparency, and 32-bit background composition with object manipulation controls. 

No matter what your experience level is, Alpha CG has a lot to offer.    We hope that you find Alpha CG an 

indispensable tool in your desktop video production projects. 



Using Alpha CG to Generate Title Graphics

Alpha CG is intended to provide a set of useful tools to a broad range of video and graphics professionals. 

It can be used as a stand-alone title graphics generator by exporting pages in    popular output file formats. 

The exported Alpha CG title pages can then be integrated into other videographics applications, such as 

paint, presentation and nonlinear video editing software. 

Specialized versions of Alpha CG are also available for specific video frame buffers and editing systems.    

Each version of Alpha CG has additional features that optimize the use of the supported video display 

hardware.    For integrated support of video frame buffers,    please contact InnoVision Technology for a list 

of compatible video hardware.



Before Proceeding

If you haven’t already done so, please take a moment to fill out the enclosed registration card and drop it in 

the mail.    Registering your product will activate your access to our technical support resources via phone, 

fax or mail.    It will also allow us to contact you concerning future program upgrades, new products, and 

special offers.    Technical support is not provided to unregistered users. 



System Requirements

Please take a moment to verify that your system meets the following minimum requirements before 

installing Alpha CG.

• Pentium 166MHz or faster

• Super VGA card (32,000 colors or higher)    supporting 640x480 VGA resolution for NTSC or PAL 

• 32 megabytes of RAM

• Microsoft Windows 95, 98, 2000 or Windows NT 

• Hard Drive with a minimum of 20 megabytes free space

• CD ROM drive for installing optional TrueType fonts

For optimum performance, the following system configuration is highly recommended:

• A Pentium II or III 450 MHz processor or higher

• 1024x768 XGA resolution with 32-bit (16.7 Million colors)

• 64 megabytes of RAM or higher

• A fast hard drive with at least 7200 RPM



Alpha CG and Screen Mode Resolution

The Alpha CG interface is designed to scale to any resolution setting that your Windows desktop can 

display.    The normal working environment for Alpha CG is 1024x768 XGA resolution with 32-bit color.    

The edit window size for the NTSC US standard is 720x486.    The edit window size for the PAL standard is 

720x576.    When using a resolution below the normal working environment, the edit window will be scaled 

down to show the entire page. 

 

Please note the Windows display font must be set to small fonts for proper display of the Alpha CG 

interface. 



NAVIGATING ALPHA CG

Alpha CG Basic Terminology

In Alpha CG, a screen containing text and graphics composition is referred to as a page.    A group or 

series of such pages is organized, saved and loaded as one project.    A project can be reloaded into Alpha 

CG for later editing.    Alpha CG also allows the user to save out a single page or an entire project in a 

specific graphic image file format for use in other videographics programs. 

Each Alpha CG page can contain any combination of text (alphanumeric characters) and graphics.    

Graphics can be internally established graphic elements such as boxes or graphic separators, and gradient 

color spread backgrounds.    They can also be image files imported from other paint and graphics software 

in full-screen or partial screen size.    By using priority level assignments, Alpha CG automatically assigns 

the text elements on a page in the foreground and the graphic elements in the background.



Alpha CG Interface

The Alpha CG interface has been designed to be easy to use.    It offers the user the flexibility of accessing 

most functions and controls through mouse, keyboard or hot key combinations.    The most common 

functions have been iconified on the main interface. 

The interface is organized into eight major areas:

· Pull Down Menus

· Toolbar

· Page Controls

· The Edit Window

· Text & Graphics Modes

· Text & Graphics Presets

· The Color Palette

· Text & Graphics Attribute Controls



Pull Down Menus 

There are seven pull down menus in Alpha CG – 

They are located on the menu bar at the top of the Alpha CG interface.    Click on any item below for more 

information about the functions and controls in each of the pull down menus.

File Menu 

Edit Menu

Attributes Menu 

Line Menu 

Page Menu 

Video Menu 

Help Menu 

 



The Toolbar

The Toolbar contains icons for the most commonly used functions.    Many are the same functions found 

inside the menu bars have been made immediately available on the interface, rather than selecting from 

the pull down menus. 

Toolbars allow you to organize the commands in Alpha CG the way you want to so you can find and use 

them quickly. You can easily move toolbars in order to redesign the interface to your liking.

The commands in the main toolbar are divided into two sections and are as follows:

COMMAND PULL DOWN MENU SHORTCUT

Open File Menu/Open Project Ctrl-O 

Save File Menu/Save Project As Ctrl-S

Cut Edit Menu/Cut Ctrl-X

Copy Edit Menu/Copy Ctrl-C

Paste Edit Menu/Paste Ctrl-V

Undo Edit Menu/Undo Ctrl-Z

Redo Edit Menu/Redo Ctrl-Y

Print File Menu/Print Ctrl-P

The second set of commands next to the I/O utilities are for text control, object selection, palette controls, 

and grid placement.

Left Justify Text Page/Left Justify Alt-Shift-L

Center Justify Text Page/Center Justify Alt-Shift-C

Right Justify TextPage/Right Justify Alt-Shift-R

Flush Justify Text Page/Flush Justify Alt-Shift-J

Justify Top

Justify Middle

Justify Bottom

Palette Menu
The palette menu button opens up another window that allows full control over colors and gradients. 

Grid On/Off
The grid function overlays a grid on top of the edit menu for precise positioning of text and graphics.    Objects 
can be snapped to the grid for exact alignment. 



Page Controls 

The Page Controls area, located on the left side of the Alpha CG interface, provides general information 

about the current page being edited, and it also displays a ‘thumbnail’ or picon (picture icon) list of pages 

in the current project. 

Page Number Box and Page Type

The Page number box displays the page number of the current page in the edit window and the total 

number of pages in the current project.    The Page Type control, also found in Page Setup command of 

the File pull down menu, is available here for user convenience.    It permits the user to designate one of 

the three Alpha CG page type options -  still, roll and crawl.    Alpha CG establishes different page 

parameters for roll and crawl pages, allowing for a dynamic page length.    (Please see the File menu 

section of the Pull Down menu section for further discussion of Alpha CG page types.) 



Creating New Pages

If a project contains multiple pages, these pages can be accessed in a linear fashion by using the PAGE 

UP and PAGE DOWN keys on the keyboard.    Pressing PAGE UP will retrieve the previous page in the 

project, and PAGE DOWN calls up the next page.    If the current page is the last page in the project and 

PAGE DOWN is pressed, a new page is created.    A new page can be created also using the command 

Insert in the Page pull down menu. 



Accessing Existing Pages

As stated earlier in this section, both the Page number box and page picon list are used for accessing 

pages in the current project.    The Page number box, in addition to displaying the current page number, 

can accept numeric input from the keyboard to recall a page in the current project and place it in the edit 

window.    Clicking on any of page picons will also bring the page into the edit window.    To view other 

pages in the project, use the vertical scroll bar to scroll through the page picon list. 

Page Picon List

The page picon list consists of a display of picons; each of which is a small color representation of one 

page in the current project.    Each page picon has a number below it, indicating the page number in the 

project.      The page annotation to the right of the page number permits the user to enter a unique name for 

the current page.    To enter a name for a specific page, left-click the page annotation field.    A dialog box 

will appear for the user to enter an unique name. 

The page picon list, as well as the Page number box, can be used for accessing pages in a project, and 

the discussion is presented in the section labeled Accessing Existing Pages at the end of this section.



Edit Window 

The large blue window located in the center of the Alpha CG interface displays the current page being 

edited in the project.    The size of the edit window in pixels is defined in the Page Setup of the File menu.    

The safe title area, a rectangular outline bordering four sides of the edit window, is present by default.    It 

provides an area where text and graphics can be placed and be completely visible regardless of the 

monitor or television that displays it.

Edit Window and Video Transparency

The default blue area of the edit window represents the video transparent area of a page.    The blue color 

of the edit window makes viewing of edges, shadows and transparency levels easier during an editing 

session.    If the page is exported in a file format with alpha channel support, such as 32-bit Targa file 

format, the blue area will allow live video to show through when displaying on video hardware that supports 

alpha channel keying.    If the page is exported in a file format without alpha channel support, the blue area 

will be saved as black with RGB colors of 0,0,0 which will facilitate luminance keying.



Text L-Cursor

An important text editing element is the text cursor or the L- cursor, which is represented as a tall vertical 

line and a short double horizontal line joined at a right angle in the shape of the letter L..    It is present in 

the edit window unless a bounding box selection is in use while in text mode. 

The L-cursor indicates where on screen text will appear when input from the keyboard.    The L-cursor can 

also indicate the current character (the character to the immediate right of the cursor) and the current text 

line (the line on which the cursor rests) for certain editing operations such as line justification.    The 

cursor’s vertical line represents the height of the current font established in the Text mode and the 

horizontal line displays the baseline of the current text line.

L-cursor Positioning
Adjusting Proportional Font Size with Text Cursor



L-cursor Positioning

In the text edit mode, the L-cursor can be easily repositioned anywhere on screen using either keyboard or 

the mouse.    To quickly position the L-cursor among existing text, simply left-click at the desired text, 

or use the four arrow keys to the left of the numeric keypad.    Pressing the down arrow will move the L-

cursor down in a page and create a new line for text entry. 

The rectangular bar along the bottom of the cursor is the L-cursor position handle, with which the cursor 

can be dragged to a new location on screen to indicate where new text will be added.    To position the L-

cursor anywhere on a page for new text entry using the L-cursor position handle, place the mouse 

pointer on the L-cursor position handle and drag it to the desired location.

Keyboard commands are also available for cursor positioning operations.    Pressing the HOME key or the 

END key will position the L-cursor to the leftmost or rightmost character on the current line.    

Pressing HOME HOME will move the L-cursor to the beginning of the first line on the current page; 

END END will move the L-cursor to the end of the page’s last line.    These last two L-cursor positioning 

operations are especially useful in jumping to the start or end of a long roll or crawl page. 

To delete the character to the right of the L-cursor, use the DELETE key.    To delete the character to 

the left of the cursor, use the BACKSPACE key.



Adjusting Proportional Font Size with Text Cursor

A new proportional font size for text entry can be interactively adjusted by using the proportional font size 

handle, the square located on the vertical line of the L-cursor.    Dragging the proportional font size handle 

toward the intersection of the L-cursor will make the font size smaller, while dragging away will make the 

font size larger.    The font size can also be changed by entering a numeric value from the keyboard in the 

Text mode, and the discussion is detailed in the Text mode section.



Text & Graphics Mode Tools 

The Mode Section contains icons pertaining to text and drawing tools which activate the text mode or the 

graphics creation modes.    The text mode allows you to edit all attributes of the text from controls located at 

the bottom of the interface.    On the right side are controls for manipulating the appearance of text.    On 

the left side are tabbed controls for manipulating the attributes placed on the text.        Visit the Text Mode 

section for full details.

The graphics mode tools allow you to control and create straight lines, boxes, circles and ellipses, and full 

screen patterns.    When entering the graphics mode, the lower right of the interface which contained the 

text mode information will be updated with graphics controls.    The left side is identical to the text mode, 

only with attributes applied to the current drawing tool. Visit the Graphics Mode section for details.



Text Mode Tool
This is the default mode of the program.    It allows freeform typing to begin immediately on the edit window.    
The bottom right of the interface contains information on the current font and its attribute settings.



Line Graphics Tool
Draws a straight line with two clicks of the mouse.    The first click marks the starting point, the second click    
marks the endpoint.    Line widths can be modified by changing the attributes settings of the line tool.



Rectangle Graphics Tool
Draws a rectangular shape using the current color.    The rectangle automatically appears in the lower third 
portion of the edit window.



Ellipse Graphics Tool
Draws an elliptical or circular shape in the current color or gradient.    The bounding box around the ellipse can 
be manipulated just like any other graphic object.    Click and drag the top or right side handles of the bounding 
box to change the aspect ratio of the ellipse.



Fill Screen Graphics Tool
The paint can icon fills the entire screen with the currently selected color or gradient.    The full screen image 
that appears becomes an editable object, just like the rectangular or elliptical objects.



Import Image
The import graphic button will load a full size or partial-screen size image onto the edit window. 



Presets

The presets area positioned at the upper right side of the Alpha CG interface displays vertically    the 

attribute presets previously stored using the command Store as Preset in the Attributes menu, or function 

key F2.      Please see the Attributes menu section in the Pull Down menu section for further discussion of 

the procedures for storing presets.

Clicking on any of the font presets will set the current attributes in the Text mode to those of the 

selected preset.    Clicking on any of the graphic presets will set the current attributes of the Graphics 

mode to those of the selected preset.    Once the preset attributes are copied into the menu, they can 

then be used for affecting new objects, or for pasting to existing objects on-screen.

To view the other presets, use the arrows or the scroll bar to the right of the preset display.



Color Palette 

The four columns of color boxes situated on the lower right side of the interface contain a set of 

predefined color schemes that can be used for text, graphics and transparency masks.    There are 220 

color boxes in an Alpha CG color palette.    To bring the other color boxes in the color palette into view, 

click the desired arrow to the right of the color palette to scroll the palette window.    Please see the Palette 

menu section for further discussion on how to create color schemes in Alpha CG. 



OBJECT SELECTION

This section explains in detail the nature and operation of selecting text and graphic objects for editing.    

Topics include the bounding box selection device and procedures of moving and scaling objects. 

Bounding Box Selection Device

The most powerful and useful editing element in Alpha CG is the bounding box.    Put simply, the bounding 

box selection device is just that - a selection box activated by the user around (bounding) text or graphics. 

The amount of text or the number of objects selected can be one character or a single graphic, or all the 

elements on the entire page, or anything in between.    Once the desired objects are selected with a 

bounding box, they can be easily repositioned or scaled using the mouse.    Nearly any text or graphics 

editing operation such as changing attributes, copying, pasting and deleting can be applied on the 

enclosed objects in the bounding box.



Drawing Bounding Boxes

The procedures outlined below describe the most common way of drawing a bounding box, starting from 

the upper left corner of an imaginary rectangle around the desired objects.    The same procedures can be 

applied if using other corners as the starting point.

Bounding Box Basics
Mouse Clicking Selections
Deactivating Bounding Boxes
Adding or Removing Individual Objects from Selection

To select a single character or graphic object with the bounding box, position the mouse pointer on 

the left side of the object, press and hold the left mouse button, and drag the mouse pointer across the 

object.    Release the left mouse button when the object is enclosed. 

To draw a bounding box around a block of text, position the mouse pointer anywhere over the first 

character at the upper left corner of the text block, press and hold the left mouse button, and drag the 

mouse pointer to the right across the text.    To draw a bounding box around adjacent text lines, drag 

the mouse pointer downward to pass below the text baseline for each desired line.    When selecting 

multiple text lines, the bounding box will readjust to surround entire lines, as opposed to individual 

characters.    When the box encloses all the desired text, release the left mouse button. 

To draw a bounding box around adjacent graphic objects,    position the mouse pointer on the upper 

leftmost object, press and hold the mouse button and drag the mouse pointer in the direction that will 

encompass all desired objects.    Release the mouse button when done.

Clicking Method to Select Text

A word or a line of text can be quickly selected using the clicking method.    To select a word, double-click 

any character of the word.    To select a line, triple-click any character of the line.    A bounding box will 

appear enclosing the word or the line.

Deactivating Bounding Boxes

To deactivate the bounding box, left-click anywhere in the edit window and the bounding box will 

disappear. 

Adding or Removing Individual Objects from Bounding Box Selection

Alpha CG provides the capability for the user to randomly select a single existing object and add it to the 

bounding box selection by using the SHIFT key.    The same method is used for removing a bounded object 

from the selection.

To add an object to the bounding box selection,  left-click on the desired object while holding down the 

SHIFT key.    To add additional objects, repeatedly SHIFT-left-clicking on all the desired objects one at a 

time until the last object is included.



To deselect any included objects in the bounding box,    use the SHIFT-click method to deselect a 

single object in the bounding box.



Advanced Tips in Drawing Bounding Boxes

Since multiple text and graphics elements can be found on an Alpha CG page, selecting the desired 

objects in the edit window can become more complicated.    Here are a few tips that may help in drawing a 

bounding box:

• Selecting individual overlapped text or graphic objects
• Selecting multiple text and graphic objects
• Drag from any corner of the imaginary bounding box
• Drag starting from an object with lower priority to an object with higher priority level

• Selecting individual overlapped text or graphic objects

When selecting objects, the starting point sets the outer limit of the objects that can be included in the 

bounding box selection.    If you have a title with a box behind it, you can select the title itself by 

dragging the mouse over the letters or you can select the box by itself by dragging only in the area 

above the letters.

• Selecting multiple text and graphic objects

If you have a title with a box behind it, you can drag the cursor across the graphic and the text line to 

include everything in the selection.    It is important to start dragging from one edge of the graphic first, 

then across the text to the other edge.

• Drag from any corner of the imaginary bounding box

The typical bounding box drawing method discussed earlier in this section is to start the process at the 

upper left corner and end at the lower right.    However, a bounding box can be drawn starting from any 

corner of an imaginary bounding box with an existing object, and then dragging the mouse toward the 

opposite corner.    To draw a bounding box to include the two text lines in the following examples, 

                ABC

EFGHIJKLMN 

start the bounding box drawing process at the lower left or the lower right corner. 

• Drag starting from an object with lower priority to an object with higher priority level

The bounding box drawing process is priority level sensitive.    It will look at the priority of the first 

object selected and allow only objects with lower priority (closer to the viewer) to be included in the 

selection.    Priority of 0 represents the top level and priority of 255 is the bottom level.    For example:

A        B        C

Priority 1        2        3  

To include all three characters in the bounding box selection, start the drawing process from the 



character C with the priority level of 3 and drag across the three characters.    If the bounding box is 

drawn starting from the character A with the priority level 1, only the character A will be included in the 

selection.    By default Alpha CG assigned lower priority numbers to text and higher priority numbers to 

graphics. 

To include another object with a different priority, SHIFT-click over any excluded object to include it in 

the selection.



Moving Selected Objects 

There are a variety of ways to move selected objects once the bounding box is activated.      If the user 

wants to fine tune the position of the selected objects in the edit window, this can be accomplished by 

using the combination of SHIFT and any of the four arrow keys.      To change the position of the 

selected objects by one pixel in a specific direction, press the desired arrow key while holding down 

the SHIFT key. 

The horizontal spacing between selected objects can also be changed by using the combination of CTRL 

and left or right arrow keys.      To change the spacing between the selected objects by one pixel in the 

horizontal direction, press the desired left or right arrow key while holding down the CTRL key.



Moving Selected Objects Using Bounding Boxes

The bounding box holds several handles for repositioning and resizing purposes.    There are three small 

rectangular handles which appear along the top and right edges of the box, as well as a bar running along 

the bottom edge.

The bottom bar in the bounding box is the position handle.    To reposition selected objects using the 

position handle, position the mouse pointer on the bar, hold the mouse button down, and drag the bar to a 

new location in the edit window.    Release the mouse button when done.    For video output it is 

recommended that text and graphics remain within the safe-title area as indicated on the edit window.



Scaling Selected Objects 

Other than using the sizing controls in the Text and Graphics modes, objects can be scaled graphically 

using the bounding box. The three small rectangles stationed along the top and right edges of the 

bounding box are the scaling handles.    These handles allow selected objects to be interactively resized 

proportionally or along independent vertical or horizontal axes. 

Proportional Scaling 

The handle in the upper right corner of the bounding box is the proportional scaling handle.    Use of this 

handle will scale selected objects while retaining their original aspect ratios or proportions both horizontally 

and vertically.    To scale selected objects proportionally, position the mouse pointer on the proportional 

scaling handle, hold down the mouse button, and then drag.    To enlarge, drag the handle toward the upper 

right of the edit window.    To reduce, drag toward the lower left.    When a satisfactory size has been 

attained, release the mouse button.    The objects will regenerate at the new size, and retain any attributes 

that have been assigned to them.

Vertical and Horizontal Scaling

The other two scaling handles provide the capability of scaling objects along only one of its dimensional 

axes.    On the top edge of the bounding box, the vertical scaling handle allows the user to resize objects 

on the vertical (up and down) axis only, while the width remains the same.    On the right edge of the 

bounding box, the horizontal scaling handle enables resizing of the horizontal (left and right) axis while 

not affecting the height.    Both handles are utilized just as the proportional scaling handle described above.



TEXT MODE

The Text mode is the central control center where the user defines various aspects of text attributes.    It is 

divided into two sections at the bottom of the screen:    the right side shows text controls, the tabbed menus 

on the left offer attribute controls.    Text controls on the right include typeface selection, type size, kerning, 

spacing, and position.    Attribute controls on the left include face color, outline size, shadow direction and 

cast transparency.    The use of the Text mode and related text attribute controls are documented in this 

section.



Text Attribute Controls

There are five major categories of text attributes: typeface properties, face, outline, shadow and cast.    The 

selected typeface appears in the area just above the Current Font box in the Text Controls section of the 

Text Mode, and its related attribute controls are on the right.    The other four categories are grouped in a 

tab submenu system located to the left of the Current Font box. 



Current Font

The combined current settings of the attribute controls in the Text mode are referred to as the current font. 

A visual representation of the current font is shown in the Current Font box in the Text mode.    Any new text 

entered in the edit window will have the same appearance as shown in the Current font box.

Adjusting Current Font Settings

There are four methods to establish the current font for affecting new and existing text.    The most 

common method is to adjust the individual controls in the Text mode.    The second method is to copy the 

attribute set from an existing character in the edit window using the Copy command in the Attributes menu 

or the Copy Attributes function key F3.    The third method is by clicking on one of the font presets located 

at the bottom of the Alpha CG interface.    The fourth method is to copy the text attributes of an existing 

character by deactivating the Lock Attributes option in the Text mode.    Using any of the    four methods will 

update the attribute settings in the Text mode. 

Using Current Font to Affect Text

To use the current font for new text, place the text cursor at the desired location in the edit window and 

type in the text.    To affect existing text on screen by replacing the attribute sets with those of the 

current font, draw a bounding box around the desired text, use the Paste command in the Attributes 

menu.    When using the Paste command, all current font settings will be applied to the text block. 

Changing Specific Attributes of Existing Text

The user may often wish to modify certain text attributes of existing text while retaining other settings, but 

he also may not want to tamper with the current font settings.    For example, the user may want to change 

the shadow size of a block of characters in the edit window without changing their different face colors.    At 

the same time he wants to retain the current font settings for new text entry on another page.    Alpha CG 

provides a quick and convenient way for the user to achieve this operation. 

Whenever a bounding box is drawn to enclose existing text on screen, Alpha CG displays the attribute set 

for the first character of the text block in the Current Font box.    The user can modify any desired attribute 

controls to affect the enclosed text.    In the above example, changing the Size control in the Shadow tab 

submenu will automatically modify the shadows of the bounded text without affecting other text attributes.    

When the user returns to the text L-cursor mode, the previously established font settings are recalled in the 

Text mode and Alpha CG is ready for new text entry.

To change a specific text attribute of a text block while retaining other attributes, draw a bounding 

box around the text, adjust the desired text attribute control in the Text menu. 



Defining Typeface

Alpha CG directly supports the TrueType font format and it does not require any additional font conversion 

to produce anti-aliased text.    Any TrueType font installed in Windows will operate in Alpha CG.    The name 

of the currently selected typeface is displayed in the Typeface list box in the Text mode. 



Bold, Italic, and Underline Options

The buttons to the right of the typeface selector provide options for creating type with bold, italic, underline, 

small caps attributes, and any combination in between.

 The Bold option will type in a larger, thicker version of the current typeface selected.    This option is only 
available on typefaces that have a bold version installed in the Windows/Fonts directory. 

 The Italic option displays a slanted, italicized version of the currently selected Truetype font.    If the font 
does not have an italic version installed in the Windows/Fonts directory, a 10 degree horizontal slant to the right 
will be added to the existing text. 

 Underline, which is one of the text attributes, draws attention to text and is appropriate for headers and 
credit rolls.    Selecting the Underline option in the Text mode will generate an underline for each new character 
typed in accordance to the settings established in the Underline dialog box.    Additional underline settings are 
controlled through a dedicated Underline dialog box in the Attributes menu. 

To apply an underline to existing text on screen, place the text cursor on the first character of the text 

block to be underlined, while holding down the SHIFT key, press the UNDERLINE key.    Holding down the 

SHIFT key and the    UNDERLINE key again will advance the cursor to the next character to be underlined. 

To remove underline for the existing text, follow the same procedures described above.



Changing Font Size and Width 

 The Size control defines the height of the current font in scanlines.    The numeric range for size setting is 5 
to 999 (scanlines), with 38 as the default.    Alpha CG provides optimal anti-aliasing of text regardless of size. 

 The Width Percentage (%) is used to alter the proportional width of the current font.    If an original 
proportional font size is desired, which is the default in all cases, the Width Percentage will be 100%.      The 
percentage value, which has the numeric range of 10% to 500%, can be raised or lowered to increase or 
decrease the font’s horizontal scale.



Character Spacing 

 Character Spacing affects the amount of space between characters.    The character spacing is based on a 
percentage of the current font size.    The numeric range is -50% to 100%, with 16% as the default.    A negative 
number for character spacing represents character overlap.      The Character Priority setting at the bottom of 
the Text mode is used to determine which character will appear on top of the another when text or graphics 
overlapping occurs.

To increase the character spacing for a text line using the keyboard,  place the text cursor on the text line, 
while holding down the CTRL key, press the right arrow key.    To decrease the character spacing for a text 
line, use the CTRL key and the left arrow key.



Character Kerning

While Character Spacing, as a general control, defines the amount of spacing between multiple 
characters on a line or a page, Character Kerning affects the space between only two characters.    It is used as 
an override for the character spacing already established between the two characters. 

Kerning is especially important for adjusting character spacing between irregularly shaped characters.    Alpha 
CG provides built-in automatic kerning between characters, making manual adjusting normally unnecessary.    
However, radically resized text using the bounding box may require manual adjustment from time to time for 
optimal output.

To adjust the kerning between two characters, position the L-cursor between the two characters that 

require adjustment.    Left-click the Character Kerning Plus (+) button to increase the kerning, and left-click 

the Character Kerning Minus (-) button to decrease kerning between two characters.    Continue until the 

preferred setting is reached.

To increase the character kerning using the keyboard, place the text cursor on the text line, while 

holding down the SHIFT key, press the right arrow key.    To decrease the character kerning for a text 

line, use the SHIFT key and the left arrow key.



Bevel

 Beveled edges can be applied to either text or graphics.    Text objects will be surrounded by an outer 
edge which produces the appearance of three dimensional chiseled type.    Graphic objects created from 
the drawing tools or images imported into the program will also produce beveled edges which conform to 
the shape of the graphic.    If an imported image has an alpha channel, the alpha channel will determine 
the shape of the bevel.    The bevel size can be up to 50 pixels and can be applied over any color spread 
or photographic image map.



Lock Attributes

The Lock Attributes toggle button is marked by a locked or unlocked padlock icon underneath the current 

font preview.    It is used for controlling whether or not the text attributes will pick up the 

 When the Lock Attributes icon is activated, the current font does not change and remains the same as the 
text cursor is moved among text on a page.    This is most useful in typing multiple fonts on a line.

 However, when the Lock Attributes function is deactivated, the text mode is always updated with the text 
attributes of the character to the right of the text cursor.    This function is useful for inserting text in the middle of 
the text block, or for picking up text attributes of an existing character. 

To add characters in a block of text with the same text attributes, deactivate the Lock Attributes option, 

place the text cursor at the desired location in the text block, and begin typing.

To quickly pick-up the text attributes at the cursor, deactivate the Lock Attributes option in the Text 

mode.    Alpha CG automatically reflects the text attributes of the character to the right of the text cursor in 

the Text mode.    To use the attributes elsewhere to affect text, activate the Lock Attributes option again. 



Priority

The Priority function at the bottom corner of the Text controls section provides the user the capability of 

changing the stacking order of overlapping objects.    In Alpha CG, each object on a page can take on a 

different position in the stack which is defined by the priority level.    The range of priority levels is from 0 to 

255, with the default text priority level of 64, and graphic priority level of 192.    Priority level of 0 represents 

the top most level, while priority level of 255 defines the bottom most level.    Alpha CG, by default, 

automatically assigns lower priority numbers (0-128) to text objects and higher priority numbers (129-255) 

to graphics,    In a normal title graphic generation, text objects will appear on top of any underlying graphic 

elements on a page. 

To change the priority level of the selected object, enter a numeric value from the keyboard, or left-click 

on the desired Priority button. 

       Clicking on the priority front button will send the selected object to the top of the stack 

            The priority back button will send the selected object to the back

            The priority plus (+) button will move the object one position up in the stack

            The priority minus (-) button will move the object one position down in the stack. 



Attribute Tab Submenus

For ease of access, the remaining categories of text attributes are organized into a tab submenu system on 

the left side of the Text Mode.    The four attribute categories are as follows:

•    Face refers to the interior of a character. 

•    Outline 1 defines an optional rim of pixels around the edge of the face character.    Outlines are often 

used to accentuate text to increase legibility.

•    Shadow 1 creates the appearance of solid extrusion directly beneath the edges of the face and outline 

of a font.

•    Cast  creates the appearance of projecting a semi-transparent, soft-edge shadow-like stamp of the font 

onto the background of the page.

Clicking on any of the tabs will bring the associated submenu into view.    The tab submenu for each 

attribute category contains controls specific to each category.    The following is a list of text attributes 

relating to each category:

FACE OUTLINE SHADOW 1 CAST

Color Color Color Color

Transparency Transparency Transparency Transparency

Bevel Size Size Size

Direction Direction

Outline, shadow and cast attributes cannot be applied to full screen backgrounds or images.    Alpha CG 

will ignore settings in those attribute controls. 

Since some of the text attribute controls appear in more than one tab submenu and they operate in the 

same manner, the following section will be devoted to describing these controls. 



Establishing Color Attributes

The Color section of the tab attribute submenu is for selecting a color scheme for the face, outline, shadow 

and cast.    The current color scheme is displayed in the Color box of the tab attribute submenu.    Any 

Alpha CG color palette box can be used to define the Color attribute.    To select a color box for the Color 

attribute, left-click on the desired color box in the color palette located at the right of the Alpha CG 

interface. 

For user convenience, the Modify Color and Load Picture functions are provided in the tab attribute 

submenu as shortcuts to quickly change or manipulate the color scheme of the current font.

To modify or create color schemes on the entire palette, you must click on the palette icon in the top toolbar 

to enter the Palette Menu. 

Modify Color

 The Modify Color function allows the user to quickly adjust the color scheme of the current font or bounded 
objects.    Clicking on the Modify Color button will display the Palette menu.    Any of the Palette menu controls 
and functions can be used to alter the current color scheme.

The newly modified color scheme in the Palette menu is not associated with any color box in the palette.    
Using the Update button at the bottom of the Palette menu will allow the user to save the new modified color 
scheme in the color palette.    To save the adjusted color scheme into the color palette, left click the Update 
button, and then left-click on the color box where the new color scheme is to be saved.

Load Picture for Texture Mapping 

 Pictures are often used for texture mapping onto the face and outline of characters to enhance the 
appearance of text.    The selected picture will fill the interior of the face or outline when texture mapping is 
performed in Alpha CG.    Clicking on the Load Picture icon will activate a file loading dialog box where the user 
can select an image file to be used as the source of texture mapping. 

To apply an image texture map to any of the attributes, it is recommended that the size of imported image file 
be slightly larger than the size of the character to be texture mapped.    However, if the image picture is smaller 
or much larger than the character, Alpha CG will automatically scale the image to fit into the face or outline of 
the character. 

Alpha CG supports the following 24-bit file formats for texture mapping of text:

•    Bitmap (.bmp) •    TIFF (.tif)

•    Targa (.tga) •    PC Paintbrush (.pcx)

•    MAC PICT (.pct) •    JPEG (.jpg)

•    Kodak Photo CD (.pcd) •    Amiga IFF (.iff)

•    Compuserve GIF (.gif)



Setting up Transparency Attributes 

The controls in the Transparency section allow the user to establish transparency settings for the text or 

graphics face, outline, shadow and cast attribute.    This function is especially important for compositing 

multiple layers of text, graphics and backgrounds.    The transparency function utilizes alpha channels to 

create the appearance of ‘see-through’ text or graphics which blends over the underlying layers of other 

elements and full screen backgrounds. 

There are three ways of applying transparency effects to selected objects and attributes: 

1. Type in a percentage of transparency from 0 to 100%. 

2. Select or modify an existing color palette box as an alpha channel map. 

3. Select a picture to be used as an alpha channel map.

For our discussion, the term visibility and transparency are often used interchangeably.    0% visibility is 

equal to 100% transparency, and 100% visibility is equal to 0% transparency. 

Transparency Level and Grayscale Value

Alpha CG defines the transparency levels in terms of grayscale values ranging from black to white.    A 

visual representation is displayed in the Transparency box.    The color black represents 100% 

transparency, where text is completely transparent over underlying layers of graphics and background.    

The color white represents 0% transparency, where text is completely visible over underlying layers of 

graphics and background.    The range of gray colors represents varying degrees of transparency where 

lighter shades are more opaque, and darker shades more transparent .    This allows the creation of 

dynamic alpha channel transparencies which would be tedious to create by other means.



Adjusting Transparency Level Using Percentage Control

The Transparency Percentage control provides a convenient way to establish uniform transparency levels 

for text.    Each face, outline, shadow and cast can take on a different transparency level.    The numeric 

range for the Transparency Percentage setting is 0% to 100%, with 0% the default for all attribute 

categories except for Cast.    The Cast Transparency Percentage is set to 25%.    The lower the 

transparency percentage, the more visible the text appears over underlying layers of graphics and 

background.



Customizing Transparency Level Using Color Boxes 

The custom transparency function is available for all text or graphic objects.    In Alpha CG, any color boxes 

in the color palette can be used to establish the face transparency level.    To assign a color box for the 

Face Transparency attribute, left-click the Custom button and then left-click on the desired color box in 

the color palette.

When a non-grayscale solid color or color gradient color box is selected for the face transparency attribute 

setting,    Alpha CG converts colors into grayscale levels.    A single color, converted to one grayscale color, 

will yield an uniform transparency for the face of the character.    A multi-color gradient, converted to multi-

grayscale pattern, will yield a variable transparency pattern for the text.

For example, a color box containing a black to white gradient pattern is selected for the face transparency. 

The top of the face will have 0% transparency (i.e., completely visible) and the bottom will have 100% 

transparency.    The middle of the character will have increasing degrees of transparency. 

Because the conversion of a non-grayscale color to a grayscale color does not always produce obvious 

results, it is highly recommended that grayscale colors be used when establishing custom Transparency 

attributes.



Using Images as Alpha Channels

 The Alpha button allows images to be used as alpha channels.    Just as images can be texture mapped 
onto text or graphics attributes, they can also be used as transparency texture maps.    This means that when 
an image is selected to be mapped onto a transparency, it will utilize the lighter colors in the image as solid, 
and the darker colors as transparent.    This opens myriad possibilities of transparency effects for text or 
graphics objects. 



Transparency Levels and Video Keying

The default blue edit window without any text and graphic elements will appear completely transparent 

when keyed over video, and will show 100% video.    When new text and graphics are created on the page 

and then keyed over video, the video transparency of the text and graphic elements will vary depending on 

the Transparency setting established in the Text and Graphics modes and their placements on the page.

For example, if a 50% transparent text is placed in the edit window with no graphics or backgrounds behind 

it.    When the page is keyed over live video, the text will appear 50% transparent over video.    If the same 

50% transparent text is partially overlapping on a completely non-transparent beveled box, when keyed 

over video, a part of the text will appear 50% transparent over the beveled box and the other part will 

appear 50% transparent over live video. 



Changing Size and Direction Attributes

The Size attribute only applies to outline, shadow and cast.    The Size attribute setting refers to the 

thickness or distance of the applicable attribute category in pixels.    The Size setting of 0 turns off the 

attribute type.    The following details the numeric ranges and default values of the Size attributes for 

outline, shadow and cast:

Numeric Range Default

Outline 0-16 2

Shadow 0-64 4 

Cast 0-99 0

Direction control for shadow and cast can be adjusted by clicking on the Direction attribute button in the 

respective tab submenu.    There are eight available direction settings, with each click rotating the shadow 

or cast 45 degrees. 

 



GRAPHICS MODE

The Graphics mode is the central control center where the user can create various aspects of text 

attributes.    Clicking on any of the drawing tools, such as line, rectangle, ellipse, and fill background tool, 

will bring up the Graphics mode.    As in the Text mode, it is divided into two sections at the bottom of the 

screen:    the right side shows image controls, the tabbed menus on the left offer graphics attribute controls. 

All attributes that are available in Text mode for typefaces are available for each graphic object.    Graphics 

controls on the right side include image height and width in pixels, height and width measured as a 

percentage, beveling, position, and priority.    Attribute controls on the left include face color, outline size, 

shadow direction and cast transparency.    The use of the Graphics mode and related attribute controls are 

documented in this section.

Using Graphic Elements

Adding Graphic Elements

Selecting Load Picture Options

Managing Imported Images

Selecting Existing Objects for Editing

Resizing Graphic Objects 

Beveling Graphic Objects

Adjusting Priority for Graphic Objects

Graphic Attribute Tab Submenus



Using Graphic Elements

A graphic element in Alpha CG can be described as any non-text object; an imported image file, either full 

screen size or partial screen, a line, box, circle, or a full screen background.    As many as 99 graphic 

elements can be composited into a background in an Alpha CG page.    The graphic elements in Alpha CG 

can be freely edited any time; they do not become permanently locked into the background when they are 

placed in the edit window. 



Adding Graphic Elements

The options available in Alpha CG to add new objects to the background are located on the Graphics 

toolbar, immediately to the right of the edit window.    The line, rectangle, ellipse, and fill background icons 

allow you to create on new graphics and enable the Graphics mode.    The last icon, load picture, involves 

importing image files from external storage device.

To add a graphic object, follow the steps detailed below:

1. Establish the attribute settings for the new object by adjusting the controls in the Graphics mode.

2. Left click on the desired drawing tool icon.    The new object will automatically appear on screen.

3. If desired, select the object, position or scale it using the handles on the bounding box, or adjust 

controls in the Graphics mode to affect the attribute settings.

4.      To deselect the object, left click anywhere in the edit window.

To perform multiple image compositing, repeat the above steps by utilizing the Add Picture icon until all the 

graphics are created.



Draw Line

 The line tool takes the currently selected attributes and draws a straight line on the screen.    Right-clicking 
on the icon will enable changes to be made on the thickness of the line.



Draw Box 

 The Add Box function adds a box to the current page as a graphic background element.    Boxes, 
sometimes referred to as graphics separators, have a variety of uses in videographics design.    Texture 
mapping a beveled box for over the shoulder graphics or creating a semi-transparent box for lower third box 
are some examples of the common usage of boxes.    If a beveled box is desired, select the Bevel Size option 
in the Face attribute submenu.



Draw Ellipse

 The Ellipse tool draws an elliptical object on the screen with the currently selected attributes.    The Ellipse 
can be resized and rotated once it appears on the screen using the sizing gadgets on the cursor. 



Fill Background

 Clicking on the Fill Background button in the Graphics mode will allow the user to create a full screen 
background utilizing any of the Alpha CG’s color boxes.    The full screen background appears automatically in 
the edit window with a bounding box, ready to be manipulated further. 



Add Picture

 The Add Picture function allows the user to import full screen or partial screen images into Alpha CG for use 
in composing backgrounds.    Clicking on this button will bring up a file loading dialog box from which an image 
file can be selected. 

Supported Image File Formats 

Alpha CG can import the following popular file formats - TIFF, TGA, JPEG, PICT, PCX, BMP, Amiga IFF, 

and Kodak Photo CD.    Any 24-bit images in the above file formats can be used for graphics and 

background creation.    In addition, Alpha CG supports the 32-bit TGA image file format.      This file format 

has a built-in alpha channel component which is often used for keying and masking. 



Selecting Load Picture Options

Once a picture file has been selected from the file dialog box, the Picture Load Options dialog box will 

appear where the user can specify how the selected image to be loaded into Alpha CG.

The Picture Load Options contain the following:

Load Size Option

Position 

Ignore and Invert Alpha Channel 

Black Trim



Load Size Option

The Load Size Option allows the user to adjust the size of the picture to be imported.    The Original Size 

option, if selected, will import the image in its original size.    The Fit to Edit Window option, depending on 

the aspect ratio of the original image, will proportionally scale the original image to cover the entire edit 

window.    The % Edit Window Size option will proportionally scale the original image to match a 

percentage of the edit window’s height or width, while maintaining the original aspect ratio.



Position

If the original size of the imported picture is less than the edit window size, the user can choose a 

placement position for the imported graphic. 



Ignore and Invert Alpha Channel for 32 Bit Images

The Include Alpha Channel option is used in conjunction with importing 32-bit picture file.    If the option is 

not selected when importing a 32-bit graphic, Alpha CG will load only the 24-bit color portion of the image. 

The 8-bit alpha channel transparency information will be ignored.    If the Include Alpha Channel option is 

selected, Alpha CG will import all 32 bits of data, including the 8-bit alpha channel information.

Invert Alpha Channel option is used for creating key hole effects.    Each black pixel in the alpha channel 

will be replaced by a white pixel, and a white pixel with a black pixel.    The gray pixels will be replaced with 

mirrored gray values in the black to white color spectrum. 



Black Trim for 24 Bit Logo Files

For an imported image such as a 24-bit logo file, the user can select the Black Trim option to remove the 

black pixel areas with RGB values of 0,0,0    surrounding the logo .    The color black in this option is treated 

effectively as transparency color (similar to the color zero transparency function found in palette based 

systems).    Alpha CG will automatically anti-alias the logo edge against the page background or video.

Be sure the logo file is saved in a 24 bit file format when using the Black Trim option.    The Alpha CG 

image loading library does not recognize monochromatic images or 8-bit images.



Managing Imported Images

When an image is retrieved from the hard disk drive for texture mapping text and graphics, or for creating 

background imagery for a page, Alpha CG stores information about the location of the image file.    When 

the page is subsequently accessed, Alpha CG will use that information to locate the imported file.    If the 

image file cannot be found at the original location, Alpha CG will prompt the user to re-select the location of 

the image file.    If the prompt is ignored, it will fill the graphic with black.

It is highly recommended that proper file management be observed.    Ideally, imported picture files should 

be kept in a fixed hard drive rather than in other removable media, such as CD ROM.    Whenever a picture 

file is loaded from a removable drive, Alpha CG will prompt the user with the option of saving the file in the 

hard drive.    The picture file will be saved in the current project folder.    Alpha CG will then load the picture 

into the current project folder directly so it can be referenced whenever the graphic is needed in Alpha CG. 



Selecting Existing Objects for Editing

To select an existing graphic element to edit, use the bounding box selection method described in the 

Object Selection section; or if an object is already selected on screen, left-click on the Select Next or Select 

Previous button until the desired object is reached.    The Select Next and the Select Previous functions 

are especially useful when editing a page containing several layers of composited images and graphics.

When an object is selected, the object element is enclosed by a bounding box.    A visual representation is 

displayed in the Current Graphic sample box.    The user can perform editing operations such as copying, 

deleting, positioning, and scaling, or affecting the attribute controls in the Graphics mode. 

To deselect an object, left-click anywhere on screen.



 Resizing Graphic Objects

 

 The first four functions on the graphics controls section deal with resizing graphics that have been loaded 
into the edit window. Scaling a graphic object can be done by using these functions in the Graphics mode, or it 
can be done interactively by dragging the scaling handles on the bounding box with the mouse.    Dragging on 
the proportional scaling handle will scale the object proportionally.    Dragging on the vertical scaling and the 
horizontal scaling handles will affect the height and width of the current graphic, respectively. 

 

 The resize functions allow the user to input specific values from the keyboard.    The size of the current 
graphic, expressed in both pixels and percentage, are displayed in the Height and Width controls.    The user 
can input the desired values directly into the 4 number boxes to scale the current graphic. 
 



PALETTE MENU

The Palette menu is used to establish and edit the color schemes in the Alpha CG's color palette.    The 

color palette is utilized frequently when working with text and graphics to specify the color attribute of an 

object.    This section will describe the controls and functions of the Palette menu and the procedures on 

how to create color schemes in Alpha CG.



Color Boxes

The color palette which splits into rows (or banks) of color boxes is located at the upper portion of the 

screen directly below the menu bar.    When in the Palette menu, all 220 color boxes in the color palette are 

visible on screen for editing.    The color box currently selected for editing is highlighted.    For easy viewing, 

a larger representation is located in the sample box labeled Current Color in the Palette menu. 



Palette Load and Save, Undo and Redo

 The current palette of color boxes can be saved for later use by clicking on the Palette Save  button.    

And a previously saved palette can be retrieved by activating the Palette Load 

 function.    For easy file recognition, Alpha CG saves the current palette with the unique file extension 
of .pal. 

Saving Palettes with Alpha CG Projects

When an Alpha CG project is saved to disk for later retrieval, the associated color palette is also saved.    

For Example, if the project is saved under the name of NEW_PROJECT, the associated color palette will 

be saved as NEW_PROJECT.pal in the same project folder.    Loading a previously saved project will also 

retrieve the associated color palette.    The default color palette in Alpha CG named Alpha_CG.pal is loaded 

for every new project.

Palette Undo and Redo

 

 Undo and redo buttons are placed in the Palette menu in order to restore changes made to palette colors.    
This provides an easy way to differentiate between the old color and new color by toggling the two different 
colors for validation. 



Types of Alpha CG Color Schemes 

A color box can contain any of the four Alpha CG’s color scheme types - solid, linear, 4 point or circular. 

 Solid color scheme generates a single color, while linear, 4 point and circular color schemes produce 
multi-color gradient spreads. 

 The linear color scheme creates linear bands of color. 

 In the circular color scheme, colors form circular color rings around a center point. 

 The 4 point color scheme, primarily used for full screen background spreads, yields a color blending 
pattern with each base color radiating from a corner of the color box.

Switching between color scheme options should be done with care.    It will permanently alter the configuration 
of the color box.    For example, switching from a multi-gradient color scheme to a single color scheme will 
result in erasure of colors.    Alpha CG will configure the color box with a single color from the previous color 
gradient. 

Positioning Center of Circular Gradients

Copying Color Boxes 

Swapping Color Boxes 

Color strip and Color Indicators 

Number of Color Indicators 

Adjusting Position of Color Indicators 

Creating a Sharp Boundary in Color Gradients 



Positioning Center of Circular Gradients

Other than displaying the currently selected color box, the Current Color box also controls the central 

positioning of a circular color scheme.    To change the central location of the circular color scheme, 

left-click on the desired location in the Current Color box in the Palette menu.    To reset the circular color 

gradient to the default central position, left-click on the option button labeled Circular. 



Copying Color Boxes

The Copy button is used to copy the color scheme of one color box into another.    To copy the currently 

selected color box, left-click on the Copy button, and then left-click on the desired destination box in the 

color palette.



Swapping Color Boxes

The Swap button is used to exchange the color schemes of two color boxes.    To swap the color scheme 

of the currently selected color box with another color box, left-click on the Swap button and then left-

click on the desired color box to be swapped in the color palette. 



Color strip and Color Indicators

A solid color scheme has one base color; whereas a gradient color spread has two or more base colors. 

For example, in a black to white gradient, the base colors are black and white.    All the base colors in a 

color scheme are displayed horizontally in the color strip located below the Current Color box in the 

Palette menu.    Each individual base color is represented by a triangular color indicator situated just 

beneath the color strip.    To select a base color for editing, left click the desired color indicator.    The 

currently selected color indicator is now highlighted, and the base color is displayed in the small box under 

the Base Color section of the Palette menu. 

The RGB/HSV values of the color indicators can be changed using the controls in the section labeled Base 

Color in the Palette menu.    The Indicator section contains functions for editing and manipulating color 

indicators.    (See the respective sections later in this section for further explanation.)



Number of Color Indicators

In a color box containing a solid color, one color indicator will appear in the color strip.    The 4 point color 

gradient will have a maximum of four color indicators.    As many as 20 colors indicators can be used for 

linear and circular color gradients.    Alpha CG automatically adjusts the number of color indicators when 

switching from one color scheme to another.



Adjusting Position of Color Indicators

To change the position of a color indicator, drag the color indicator to the left or right until the desired 

location is reached.    The relative position and spacing of color indicators determines the rate of tapering 

between the base colors in a color gradient.    This is especially important in the linear and circular color 

schemes.    Each color indicator marks the point at which a base color in the color strip blends outward 

toward another.    If the color indicators are set far apart, a smooth blending occurs between the colors.    If 

the color indicators are set close together, the resulting color gradient will appear more abrupt.    The 

position and spacing of color Indicators can be changed to achieve a variety of color gradient effects.



Creating a Sharp Boundary in Color Gradients

Two color indicators can occupy the exact same position in the color gradient strip to create a sharp 

boundary between two colors in a color gradient.    To create a sharp boundary in a color gradient, drag 

one of the two color indicators left or right until it reaches the exact location of the other color indicator.    

When a color indicator is dragged on top of another indicator, the indicator that was moved will overlap the 

second indicator.    The color gradient generated will have the color on the right side corresponding to the 

top color indicator and the color on the left side corresponding to the bottom indicator. 



Editing Color Indicators

The Indicator section of the Palette menu consists of functions to edit color indicators. 

The Add, Delete, and Clear buttons are used to edit the current color gradient. 

The buttons Space, Shift, and Invert provide a quick way to easily manipulate a color gradient without 
going through numerous steps. 

Add

 The Add button is used for adding a new color indicator.    The color of the new indicator will be based on 
the color that is currently displayed in the current base color box.    A highlighted triangular color indicator will 
appear in the color strip. 

Delete

 To delete a currently selected color indicator, left-click on the Delete button.    The color indicator will 
disappear.

Clear

 The Clear function is used to remove all color indicators in a gradient except one color indicator. 

Space

 The Space function allows the user to define a evenly spaced color gradient without adjusting each color 
indicator manually

Shift

 The Shift function moves the color indicators one position to the left while maintaining the current spacing 
between the indicators. 

Invert

 The Invert function reverses the order of colors and spacing of the color indicators.
  



Rotating Linear Color Gradients

The Rotate Gradient slider, represented by the horizontal scroll bar, is used to determine the Z rotation of 

the linear color gradient.    It does not affect the solid, circular and the 4 -point color schemes.    The 

numeric range of the Rotate Gradient slider is 0 degrees to 360 degrees, with 0 the default. 



Current Base Color

The current base color is defined by the highlighted color indicator in the color strip.    The color is 

displayed in the small sample box in the Base Color section of the Palette menu.    The current base color 

can be changed by using the color sliders in the Base Color section of the Palette menu. 

Video Safe Color Option
Color Mode and Color Sliders



Video Safe Color Option

Colors which use higher saturation levels, those over approximately 75%, will in most cases produce 

‘bleeding’ and color distortion when converted to NTSC or PAL video.    The 75% level is indicated by the 

saturation value of 192.    To establish video safe colors, select the option labeled Video Safe, or simply 

change the saturation level to no higher than 192, represented by the S slider in the HSV color mode. 

The Video Safe option, if activated, will not change the values in the RGB/HSV sliders.    Instead, any 

object will be adjusted for video safe colors when it is displayed in the edit window and the preview output 

monitor.    Anytime this option is not selected, all color rendering in Alpha CG will be based on the entered 

RGB/HSV values. 



Color Mode and Color Sliders

The two color    modes available in Alpha CG are RGB and HSV.    The RGB mode will configure each of 

the three color sliders, the horizontal scroll bars located below the current base color box, as one of the 

primary video colors (Red, Green, or Blue).    The HSV mode will configure the three sliders as Hue, 

Saturation, and Value.    The RGB mode is the default.

The color sliders can be adjusted individually for each of the RGB/HSV color components.    The numerical 

range for each RGB/HSV slider is 0 to 255.    For example, an RGB value of 255, 0, 0 will yield pure red.    

The current numerical value of each slider is displayed in the input boxes to the right of the color sliders.



The OK and Cancel Functions

The purpose of the cancel function is to return the color schemes of the color boxes to the state when the 

Palette menu was first accessed.    Alpha CG will ignore all operations performed to the color boxes. 

To exit the Palette menu and return to the Text mode, left-click on the OK button.    The user can also 

enter any of the Alpha CG’s primary menus by activating any of the menu buttons located in the upper right 

corner of the Alpha CG interface.



 Updating Color Boxes 

When the Palette menu is accessed by activating the Modify Color button in the Text or the Graphics 

mode, the extra function Update Color Box, is made available for the user to save the modified color 

scheme in the color palette.    When the Palette menu is accessed through the Palette button at the top of 

the Alpha CG interface, a color box is always highlighted for editing.    Adjusting any controls in the Palette 

menu will automatically update the color box in the color palette.    However, when the Palette menu is 

accessed via the Modify Color function in the Text or the Graphics mode, the edited color scheme is not 

linked to any of the color boxes in the color palette.    Alpha CG provides the user the Update Color Box 

option to save the newly modified color scheme in one of the color boxes for later use. 

To save the newly modified color scheme in a color box when accessing the Palette menu via the 

Modify Color function in the Text or the Graphics mode, left-click the Update Color Box button in the 

Palette menu, and then left-click on the desired color box in the color palette to store the modified color 

scheme.



PULL DOWN MENUS

There are seven pull down menus in Alpha CG – 

They are located on the menu bar at the top of the Alpha CG interface.    The functions and controls for 

each of the pull down menus are discussed in this section.

File Menu 

Edit Menu

Attributes Menu 

Line Menu 

Page Menu 

Video Menu 

Help Menu 



File Menu

Most commands in the File menu are related to the basic file operations such as saving and loading of 

projects.    Also appearing in the File menu are commands for setting up page parameters. 

Project Management Commands

Exporting Pages & Projects

Exporting 32 Bit Key Pages

Saving Roll/Crawl Files

Importing Text

Project Management Commands

The first three commands in the File Menu - New Project, Open Project, and Save Project control the basic 

project management tasks.    An Alpha CG project is defined as pages organized, saved and loaded as a 

group.    The number of pages in a project can range from 1 to 999 pages.

Selecting any of the project management commands will activate a dialog box where the specific file 

operation will be executed.      When the Save Project command is activated, it creates a folder bearing the 

user defined project name.    The project file with an .acg file extension is saved in the folder.    The 

associated color palette with a .pal file extension for this project is also saved.    Please note that all Alpha 

CG projects must be saved in the sub-directory named alpha_cg\projects\ for the project to be 

displayed correctly when subsequently retrieved.

Any time Alpha CG is launched, a new project is opened and it is ready for the user to create title pages.    

If desired, however, the user can recall a project previously saved by using the Open Project command.    

To open a previously saved project, select the Open Project command.    When the Open project dialog 

box appears on-screen, left-click on the folder where the desired project file is located, and then left-click 

on the desired project file with the file extension .acg.    Alpha CG only allows one project to be opened at a 

time. 

Exporting Pages and Exporting Projects

The next two items, Export Page As and Export Project As allow the user to save out the current page or 

project in a specified image file format.    These pages can then be utilized in other videographics 

applications.    Unlike the Save Project command previously discussed in the last section, image files saved 

with these two commands will no longer be editable when re-loaded back in Alpha CG; although they can 

be used in Alpha CG as full screen background images for graphic composition. 

The following is a list of export picture file formats supported by all versions of Alpha CG:

•    24-bit Bitmap (*.bmp)

•    24-bit TIFF (*.tif)



• 16-bit Targa (*.tga)

•    32-bit Targa (*.tga)

•    24-bit PC Paintbrush (*.pcx)

•    24-bit MAC PICT (*.pct)

•    24-bit JPEG (*.jpg)

•    24-bit Amiga IFF (*.iff)

Other hardware specific file formats are included depending on the version of Alpha CG installed. 

The Export Page As allows the current page displayed in the edit window to be saved as an image file.    

The Export Project As command saves all the pages in the current project.    When saving the current 

project in a specific image file format, the user can input a file name with up to five alpha numeric 

characters.    Alpha CG will save the pages in a special file naming convention of filenamexxx, where xxx 

represents the page number in the project.    For example, filename001, filename002 and so on.

Exporting 32 Bit Key Pages and Video Defringe Option

The video defringe option in the Video pull down menu is especially important when exporting 32-bit key 

pages to be viewed over video.    The defringe function removes the fine black rim around the edges of light 

colored text and graphics in a key page that does not have black edge attributes.    When the defringed key 

page is subsequently viewed over live video, the key edges of text and graphics will retain the highest level 

of anti-aliasing.      By default, the video defringe option in the Video menu is on. 

For further explanation on the Video Defringe function, please see the Video menu discussion later in this 

section. 

Saving Roll or Crawl Files

If a roll or crawl page is saved in a file format that does not support extended page lengths, Alpha CG will 

only save the page defined by the edit window size, and some of the screen page content will not be 

saved.    If a file format can support extended page length, Alpha CG will save the entire roll or crawl as a 

single extra wide or extra tall graphic file.    The roll and crawl file formats exported will depend on the 

hardware and software supported by Alpha CG.

Importing Text

The Import Text function allows for text files to be imported, especially useful in a long roll page.    Alpha 

CG supports the following formats:

ASCII Text (.txt)

Windows Words (.doc)

Write (.wri)



Before importing a text file into Alpha CG, all text attributes that are to be applied should be established in 

the Text mode.    The Page Type should be selected beforehand, particularly in a roll page, as well as other 

text settings such as page justification, character and line spacing.    Word wrap option is automatically 

applied to text import when appropriate.



Edit Menu

The commands in the Edit menu are functions applied to selecting and editing objects.    They are usually 

used in conjunction with the bounding box selection device.

Undo and Redo Commands 
Copying and Cutting Text and Graphics
Paste 
Object Selection

Undo and Redo Commands

The Undo and Redo are powerful functions which make experimentation easy in Alpha CG.    These 

commands are also located at the lower right corner of the Alpha CG interface.    The Undo button allows 

the user to erase the last edit operation.    The Redo button will cancel an undo operation after an undo 

command is performed.        Both functions can be accessed using the function keys F11 or CTRL-Y for 

Redo and function key F12 or CTRL-Z for Undo.    The undo function can be used repeatedly to undo up to 

32 of the most recent edit operations.

Copying and Cutting Text and Graphics

The copy function allows enclosed object to be duplicated from its current location, to be later deposited in 

a new area of the same page or to a different page within the project.    To copy using the Edit Menu, 

select the desired text or graphic using the bounding box, and then select the Copy command.    The 

selected text or object will be copied into an internal copy buffer.    The hot key combination for the copy 

function is CTRL-C.

The Cut function works in a similar manner as Copy, except that it removes the selected object that has 

been copied from its original position.    To cut using the Edit menu, select the desired object using the 

bounding box, and then select the Cut command.    The hot key combination for the cut function is CTRL-X. 

Paste

The Paste function will paste text or graphic that has been copied or cut.    To paste text or graphic that 

has been copied or cut to a new location, select the Paste command.    The graphic object will appear 

on screen.    The user can then use the bounding box to position the object to the desired location on the 

page.    The hot key combination for the copy function is CTRL-V.

Object Selection

The first three Select commands in the Edit menu provide a convenient way for the user to select a specific 



type of objects to be included in the bounding box selection.    Select All command will select all text and 

graphic objects on a page.    Select Text will select text objects only, and Select Graphics will include 

graphic objects only. 



Attributes Menu

The commands in the Attributes menu are for copying and pasting attribute settings of text and graphics, 

storing the current text or graphic attributes as a preset for later use, and establishing text underline 

parameters.    Attributes constitute the visual appearance of text or graphics which are defined in the Text 

and Graphics modes.    Alpha CG retains two separate sets of attributes, one for text and one for graphics. 

Please see the Text and Graphics mode sections for the discussion of how to establish attribute settings.

Copying Attributes

Pasting

Recalling Default Attributes

Storing Attribute Presets

Pasting with Attribute Presets

Establishing Underline Parameters

Copying Attributes

The Copy Attributes command copies all attributes applied to the current object.    Once an attribute set is 

copied, it will appear in the Current Font or the Graphic box.    The copied attribute set can be used for new 

text entry or graphic generation.    If desired the user can apply the attribute set to any existing selection by 

using the Paste Attributes command.

Both menu and keyboard commands are available for copying attributes.    To copy an attribute set from 

existing text on-screen using the Edit menu, position the text cursor to the left of a character retaining 

the attributes to be copied or draw a bounding box around the character, and then select the Copy 

Attributes command.    To copy an attribute set from an existing graphic object using the Edit menu,    

draw a bounding box around the desired object and select the Copy Attributes command.    To copy an 

attribute set using the keyboard, use function key F3. 

Pasting Attributes

The Paste Attributes command will apply the copied set of attributes to text or graphic objects selected 

with a bounding box.    If no text is selected with a bounding box, all of the copied text attributes will be 

pasted to the current character only (to the right of the text cursor). 

Both menu and keyboard commands are available for pasting attributes.    To paste the copied attributes 

to existing on-screen text or graphic using the Edit menu, draw a bounding box around the object to 

be affected, and select the Paste Attributes command.    To paste the copied attributes using the 

keyboard, use function key F4.

Recalling Default Attributes 



Since text and graphic attributes are carried forward during an edit session in Alpha CG.    After making 

numerous adjustments to the menu, the user may wish to return all attributes settings back to the default 

values.    By activating Recall Defaults command, all attribute settings and values are reverted back to 

those found when Alpha CG is first launched.    The user can also use the function key F1 to activate the 

Recall Defaults command. 

Storing Attribute Presets

Alpha CG offers the capability to store favorite text or graphic attribute sets for immediate recall.    With the 

Save as Preset command, the current attribute set in the Text or Graphics mode can be saved into a 

preset buffer.    The visual representations of all the previously saved attribute presets are displayed online 

at the bottom of the Alpha CG interface.

To store the current attribute set as an attribute preset, select the Save as Preset function in the 

Attributes menu, and then click on an attribute preset box at the bottom of Alpha CG interface.    To store 

an attribute preset using the keyboard, press function key F2. 

To use an attribute preset, click on the desired preset.    The attribute preset will automatically appear in 

the Current Font or Current Graphic box and it is now ready to be used for new text entry or new graphic 

creation. 

Pasting with Attribute Preset

If an existing on-screen object is enclosed with a bounding box, clicking on one of the attribute presets will 

paste the preset attributes to the selected object.    The current attributes in the Text or Graphics mode are 

not affected.    To paste a preset attributes to an on-screen object, draw a bounding box around the 

desired object, click on the desired attribute preset. 

Establishing Underline Parameters 

Underlines draw attention to selected text and are appropriate for headers.    They are also useful as 

graphic separators or ‘spacers’ on a roll page.    The Underline option is available in the Text mode to 

activate an underline.    The color, height and offset of the underline for text is determined by the settings 

established in the Underline menu. 

Underline contains a global setting that applies to all text for a particular page.    Each page in a project can 

have its own underline settings.    Once the parameters are changed in the Underline dialog box, they will 

carry forward to subsequent new pages.    To change the RGB color, height and offset of underline, 

select the Underline command, and then adjust the desired parameters.    The default underline color is red 

with RGB values of 192-64-48.    The numeric range of the Underline Height is 1 to 32 pixels, with 4 as the 

default.    The offset represents the vertical distance in pixels from the text baseline to the underline.    The 

numeric range for Underline Offset is +128 to -128,    with 4 as the default.    Entering a negative value for 

offset will shift the underline upward from the baseline of the text.





Line Menu 

The Line Menu provides commands for editing lines, adjusting line spacing and justifying text lines.    A text 

line can be considered as the horizontal ‘space’ that text can rest on.    It includes all lines with text and the 

empty line where the text cursor is positioned.    Also, any time a text cursor is dragged to a new position for 

new text entry in the edit window, a new line is created. 

The Line menu does not contain any of the cut, copy and paste line editing commands.    These line editing 

operations can be easily achieved by using the bounding box, and then applying the Cut, Copy and Paste 

commands in the Edit menu.

Line Menu Commands and Freeform Text Layout 

Clearing, Deleting, and Inserting Lines 

Changing Line Spacing 

Justifying Lines

Line Menu Commands and Free Form Text Layout

The Line menu commands are designed to be used in a fixed form text layout where specific line spacing 

and justification are desired for the entire page.    This type of layout is often found in a roll page or a still 

page containing a table.    However, Alpha CG provides the added capability of free form text layout where 

characters and lines can be positioned anywhere on-screen with overlapping control.    Using the Line 

menu commands in a free form text layout may sometimes produce undesirable results. 

All the Line menu commands discussed in the following section, unless otherwise noted, can be used in 

conjunction with the text cursor or the bounding box for a fixed form formatted page.    It is highly 

recommended that the bounding box be used in a free form formatted page.    Before activating any of the 

Line menu commands, use either methods to select the desired text line.

Clearing, Deleting and Inserting Lines

The first three commands in the Line menu are for clearing, deleting and inserting text lines.    Clearing a 

text line will clear the text in the current line, but not the horizontal space.    Deleting a text line will clear 

the text and the horizontal space of the selected line.    Any existing lines that were underneath it will be 

readjusted upward to fill in the space. 

Inserting a line works only in text cursor mode, where the user can define whether a line is to be inserted 

before or after the current line.    If this command is activated, a new text line will be inserted and all lines 

underneath is repositioned downward on the page.    Using the INSERT key from the keyboard will insert a 

line before the current line.

Changing Line Spacing



Line spacing controls the vertical empty space in between successive lines of text.    Use of the line 

spacing command may be necessary if font sizes are changed after text has already been entered, or if 

different font sizes are used on the same text line. 

Both the text cursor or bounding box methods can be used with line spacing.    Adjusting the line spacing in 

the text cursor mode will affect the spacing between the current line and the line above.    In the bounding 

box mode, the line spacing will change the spacing of the enclosed text lines.

When the Line Spacing command is activated, a dialog box appears.    The user can enter the desired 

value.    The numeric range for line spacing is -64 to 64, with 12 the default.    This number if changed will 

carry forward for any new text entry.    Entering a negative number will cause text lines to overlap. 

Justifying Lines 

Line justification settings establish accurately centered and aligned text.    There are three available line 

justification commands in the Line menu -    Left, Center and Right.    The default setting for justifying lines 

is left-justification, aligning a text line to the left page margin.    Center-justifying a line will align it perfectly 

within the horizontal center of the edit window.    And right-justification will cause alignment on the right 

page margin. 

Line justification through keyboard commands offers an efficient equivalent to the menu items.    First select 

the line with the text cursor or the bounding box.    To left-justify the selected text from the keyboard, 

press ALT - L; to center-justify, press ALT - C; to right-justify the current line, press ALT - R.    The 

keyboard justification command also works to justify the text cursor on a blank line.    Finally, a keyboard 

based justification toggle using the function key F5 Justify Line is available as well, which cycles through all 

justification modes sequentially. 



Page Menu

The Page menu consists of commands affecting the current page displayed in the edit window such as 

cutting, copying, pasting and inserting pages, adding full screen images, activating word wrap, clearing 

objects and justifying text. 

 

Cutting, Copying, Pasting, and Inserting Pages
Adding Pictures
Activating Word Wrap
Clearing Pages
Justifying Pages Horizontally 
Justifying Pages Vertically
Setting Up Page Parameters
 

Cutting, Copying, Pasting and Inserting Pages

The commands of Cut, Copy, Paste and Inserting Page are used in conjunction with the page picon list 

located at the left hand side of the Alpha CG interface.    Before performing any of these commands, select 

the desired page in the page picon list.    The page now appears in the edit window.    Cut Page will 

eliminate the current page; it can be used with the Paste Page command if desired .    All the subsequent 

pages after a Cut Page command is performed will be moved upward and renumbered. 

Copy Page works similarly as the Cut Page except it will not remove the current page.    Paste Page 

allows the user to copy the page previously cut or copied to a new location.    The user can choose the 

option of pasting the copied page before or after the current page displayed in the edit window.    Insert 

Page will add a blank page either before or after the current page.

Adding Pictures 

Alpha CG allows the user to quickly load in a picture file from an external source.    It is the same function 

as the Add Picture function in the Graphics mode.    Please see the discussion in the Graphics mode 

section for further explanation.

Activating Word Wrap

The Word Wrap command moves the text cursor to a new line automatically when a line is filled with text. 

The user does not need to press the ENTER key to create a new line.

Clearing Pages

There are three Clear Page commands in the Page menu - Clear All, Clear Text and Clear Graphics.    



The Clear command will eliminate the specific type of objects selected in the menu.    Clear All will clear 

everything, text and graphics from the current page.    Clear Text will clear text only and Clear Graphics will 

clear all graphic objects.

Justifying Pages Horizontally 

Two types of page justifications can be found in Alpha CG.    The horizontal justification aligns the page 

either left, center, or right.    These commands works the same way as the those in the Line menu, except 

they affect all text lines on the current page.    Any text lines with tabs will not be adjusted by the horizontal 

page justification commands.    To left-justify the page from the keyboard, press ALT -SHIFT- L; to 

center-justify, press ALT -SHIFT- C; to right-justify the current page, press ALT -SHIFT- R.    Pressing 

function key F6 will cycle through the three horizontal page justification commands    - left, center and right. 

Justifying Pages Vertically

The text lines can be justified quickly at the bottom of the Lower 3rd portion of the page.    This page 

justification is useful for captioning and sub-titling. 

Setting up Page Parameters 

Selecting the Page Setup command will recall a dialog box from which the user can establish the page 

type, page margins, tabs, grids, safe title area and edit window size.    The default button in the Page Setup 

dialog box will return all values to default values if activated. 

Page Type

Page Center Offsets

Page Margins

Tabs

Safe Title Area

Grids

Edit Window Size



Page Setup Options
Page Type

Still, roll and crawl are the three page type options available in Alpha CG.    For user convenience, the 

same page type control can also be found in the project control area at the left side of the Alpha CG 

interface. 

It is recommended that the page type be defined for a new page before entering text or creating graphics. 

Alpha CG establishes special working parameters for each page type. 

The still page is the default page type.    The size of a still page is fixed, and it is defined by the dimensions 

of the edit window size. 

The roll page is designed so that the roll document can be easily be edited by scrolling the document 

within the edit window.    Often times a roll page will have more text lines than what the edit window can 

accommodate.    The Alpha CG roll page automatically extends the edit window downward for more text 

entry if necessary. 

The crawl page works in the same manner as the roll page, allowing for dynamic page length in a 

horizontal direction.    When the crawl page is played back, text will be scrolled in the right to left direction 

as if it was a single extended line of text. 

Page Center Offsets

The Vertical and Horizontal Center Offsets are for defining a new center position of a page.    In a typical 

page, the horizontal center is the half way point between the left and the right edges, and the vertical 

center is half way between the top and the bottom of the page.    For certain video hardware, the page 

display may be shifted to the right or the left, or to the top or the bottom.    This causes an exported Alpha 

CG page to display off center when viewed on the video output monitor. 

To compensate the hardware display shift, the center point of the Alpha CG page can be offset a given 

number of pixels in X or Y axes as defined by the user.    Any changes made to the page center offset 

option will automatically affect the safe title area, page margins and tabs to compensate for the shift.    

Using this option, text alignment and safe title area will appear shifted in the edit window, but will appear 

center when displayed on the video output monitor.

By default, the vertical and horizontal page center offset is 0, with input ranges from -99 to    99 pixels.    A 

negative number represents the shifting of the    screen center to the left or to the top based on the amount 

of pixels inputted.

Page Margins 

The next command in the File menu is for setting page margins, the physical borders around the edges of 

Alpha CG text pages.    It is used mostly for normal text entry operation using the text cursor.    However, 

the margins can be overridden if the bounding box is utilized for repositioning text.    Page margin settings 

should ideally be established before entering text on a page.    Changes made to the page margins are 



carried forward and they are retained for any new pages created afterward.

The four Page Margin commands adjust the top, bottom, left and right margins respectively.    The 

numerical settings for margins refer to the absolute screen coordinates in pixels across and scanlines 

down the page.    The default margin settings are determined by the edit window size. 

Tabs 

The user can define up to 8 tabs for each Alpha CG page.    The tabs, like page margins, once changed are 

carried forward to subsequent new pages.    The default tab settings, refer to absolute horizontal pixel 

values, and are evenly spaced between the left and right page margins.    Once the tabs are set, pressing 

the TAB key in the text edit mode will bring the text cursor to the established first tab position.    Pressing 

TAB again will advance the text cursor to the next tab position. 

Safe Title Area

The safe title area indicator is displayed in the edit window as a rectangular outline.    The safe title area is 

the center region of the page in which text and graphic elements can be placed and be completely visible 

regardless of the monitor or television that displays them.    The safe title area, therefore, is useful for 

designing title screens for video output as consumer TV sets vary widely in the degree of the visible 

overscan area that they can display.

Unlike the physical boundary of the page margins to restrict text entry within a defined area, the safe title 

area is a passive reminder for placing text and graphics in the edit window.    The safe title area is defined 

by a percentage of the edit window size.    The numeric range for safe title area is 60% to 100%, with 80% 

the default.    By default the safe title area indicator is always displayed.    If desired, the user can de-

activate the option by deselecting the Show Safe Title Indicator to hide the indicator.

Grids

The Grid function is used for aligning objects to specific points on the X and Y axes.    The user can 

activate the grid options by selecting the desired Vertical or Horizontal options.      The Spacing column 

under both options defines the space between each point along the X and Y axes.    The Offset column 

defines relative position of the grid from the left and top edges of the edit window. 

The Show Grids option, when activated, displays the grid lines in the edit window.    The Snap to Grid 

option, if selected,    restricts the placement of the selected object in the bounding box to the closest grid 

point based on the lower left corner of the object.    When using the ENTER key to create a new text line 

with the Snap to Grid option activated, the text cursor will advance downward to the next lower grid point in 

the edit window. 

Edit Window Size

The edit window size defines the output resolution of a page.    If Alpha CG has direct support for the 

installed video hardware, it automatically detects the output resolution and places the values in the edit 

window size number boxes.    If Alpha CG is used as a stand-alone title graphics generator, the default 

values of the edit window size will be set to 640x480 for NTSC and 720x576 for PAL.    The maximum 



supported edit window size is 768 x 576.

The values in the Edit Window Size are used to calculate the default settings for page margins and safe 

title area.    A change in the edit window size is only advisable when the user wishes to export title pages 

and use them in hardware with different video output display dimension.    Otherwise the edit window size 

should be left intact. 



Video Menu

The commands in the Video Menu are related to selecting video input sources and other display options for 

previewing purposes.    The Video Setup command in this menu is hardware specific and it may not be 

available unless the hardware is directly supported by Alpha CG.

Selecting Video Setup Parameters
Video Defringe Option
Anti-Flicker Filter

Selecting Video Setup Parameters

When the Video Setup command is activated, a dialog box will appear in which the user can choose a 

video overlay source and a video preview update option. 

Video Overlay Source

The Video Overlay Source defines the location of the video input for overlaying text and graphics when 

the current page is previewed on an external video output monitor.    The Black input or program option 

selects a solid black preview background.    The other options select the available video input sources 

which may vary depending on the system used. 

Video Preview Update

The Video Preview Update option permits the user to establish how frequently the page preview is 

updated on the preview monitor.      The Auto option updates the current page two seconds after the last 

change is made in the edit window.    Manual option lets the user manually update the preview screen by 

using the Preview button at the upper left corner of the Alpha CG interface or by pressing function key F9. 

The Real Time option renders the current page to the preview output whenever any change is made to the 

page. 

Video Defringe Option

The video defringe option in the Video pull down menu is especially important when exporting 32-bit key 

pages to be viewed over video. 

In a key page, the defringe function removes the fine black rim around the edges of light colored text and 

graphics that do not have black edge attributes.    When the defringed key page is subsequently viewed 

over live video, the key edges of text and graphics will retain the highest level of anti-aliasing. 

However, if the defringed page is viewed using typical RGB graphics programs, the edges of some objects 

may appear jagged depending on the color of the edge attributes assigned in Alpha CG.    These programs 

are only displaying the 24-bit image and are not applying the 8-bit alpha channel which would remove the 

jagged edge aliasing. 



Alpha CG will not apply video defringe processing to any pages exported in a 24-bit file format.    However, 

if a key page is exported in a 32-bit file format, by default video defringe processing will be applied.    The 

user can turn the video defringe processing off by deselect the Video Defringe option in the Video menu.

Anti-Flicker Filter

The Anti-Flicker Filter option performs an extra image processing function on the page when it is exported 

or previewed over video to remove flickering on the video output.    This flickering can occur around the 

brightest or highlighted areas of text or graphics.    This function can appear to slightly soften the image in 

some cases.    By default the anti-flicker filter is off.



Help Menu

The Help menu contains information about the version number of the software, as well as this online help 

file.
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